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1.  ORDERING GUIDE, SERIAL INPUT TRANSMITTER 

Configure a model number in this format: LTS60, CBL04 

LTS6…Transmitter with 4-20 mA, 0-20 mA, 

0-10V or -10V to +10V isolated analog 

output, RS232 or RS485 serial data 

input, and dual 120 mA solid state 

relays. Default jumpered for RS232. 

 LTSE6E… Transmitter with 4-20 mA, 0-20 

mA, 0-10V or -10V to +10V isolated 

analog output, Ethernet serial data 

input, and dual 120 mA solid state 

relays. 

Power 

0............................. 85-264 Vac or 90-300 Vdc 

1................................. 12-30 Vac or 10-48 Vdc    

ACCESSORIES 

CBL04……RS232 cable, two 3-pin connec-

tors on transmitter end, DB9 

connector on computer end. 

CBL02……USB to DB9 adapter cable. Can 

be used with CBL01 or CBL04. 
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3.  INTRODUCTION, RS232 OR RS485 SERIAL INPUT TRANSMITTER 

 
 

The LTS serial input to analog output transmitter (or serial-to-analog converter) accepts 

numeric readings embedded in streaming RS232 or RS485 ASCII serial data, and converts 

these to an isolated, scalable 4-20 mA, 0-20 mA, 0-10V or -10V to +10V analog output. It also 

accepts Modbus RTU or Custom ASCII protocol commands to output a specific current or 

voltage. The unit fits on a 35 mm DIN rail and is only 22.5 mm (0.89") thick. Model LTS60 can 

be powered by 85-264 Vac AC line voltage. Model LTS61 can be powered by low voltage AC or 

DC, like 24 Vdc. All electrical connections are via detachable screw-clamp plugs. LTS models 

use an LT counter transmitter board, but no signal conditioner board. LT counters with a signal 

conditioner board, like model LT60FR, can also be used for serial to analog conversion. 

The current or voltage transmitter output is jumper selectable and is transformer isolated to 

avoid ground loops. Either output provides 16-bit resolution of the output span and is ultra-

linear to within one bit. The output is scaled to the serial input in software. Rated accuracy is 

±0.02% of span. 

Dual solid state relays rated 120 mA at 140 Vac or 180 Vdc are standard. The relays can 

respond to the transmitted serial values or to transmitted control characters, which override the 

internal setpoints. The relays can also be controlled independently of the serial input by 

applying signals to control inputs 1 and 2.  

Isolation to 250V rms is provided for power, the serial data input, analog output, and relay 

outputs. Isolation adds safety and avoids possible ground loops. 

Serial data input selections are RS232, half-duplex RS485, or full-duplex RS485. Selection is 

via jumpers and/or at the connector. 

Transmitter setup is via the unit’s serial port using an external PC and Instrument Setup 

software, which can be downloaded from our website at no charge. The required 3-wire 

transmitter-to-PC interface RS232 cable (CBL04) is easy to build and is also available for 

purchase. Plugging cable CBL04 into a CBL02 RS232-to-USB converter cable allows the LTS 

unit to be programmed via the USB port of a PC. 

The LTS is not plug and play. The format of the strings being received must be known in 

advance, including non-printing control characters. If you do not know the format of your ASCII 

data, contact tech support of the manufacturer of the sending device. Or use a terminal 

emulator PC program, like HyperTerminal, PuTTY or RealTerm, to view the received data on 

your PC.  

The LTSE6 Ethernet input to analog output transmitter accepts streaming Ethernet data and 

converts it to an isolated, scalable 4-20 mA, 0-20 mA, 0-10V or -10V to +10V analog output. 

That transmitter is covered by a separate user manual. 
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4.  RECEIVING & UNPACKING YOUR TRANSMITTER 

 

Your transmitter was carefully tested and inspected prior to shipment. Should the transmitter be 

damaged in shipment, notify the freight carrier immediately. In the event the transmitter is not 

configured as ordered or is inoperable, return it to the place of purchase for repair or replacement.  

Please include a detailed description of the problem. 
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5.  SAFETY CONSIDERATIONS 

 
 

 Warning: Use of this transmitter in a manner other than specified may impair the protection 

of the device and subject the user to a hazard. Visually inspect the unit for signs of damage. If the 

unit is damaged, do not attempt to operate. 

Caution:  

• This unit may be powered with AC (mains) from 85-264 Vac or 90-300 Vdc with the high 

voltage power supply option, or 12-30 Vac or 10-48 Vdc with the low voltage power supply 

option. Verify that the proper power option is installed for the power to be used. This 

transmitter has no AC (mains) switch. It will be in operation as soon as power is applied. 

• The 85-264 Vac or 90-300 Vdc mains connector (P1 Pins 1-3) of model LTS60 is colored 

green to differentiate it from other input and output connectors. The 12-30 Vac or 10-48 Vdc 

mains connector of model LTS61 is colored black. 

• The analog output is sourcing. Do not connect the 4-20 mA analog output to a load designed 

to apply 24 Vdc to a two-wire transmitter. Applying 24 Vdc will burn out the main board. 

• To avoid dangers of electrocution and/or short circuit, do not attempt to open the case while 

the unit is under power. However, signal wiring changes external to the case can be made 

safely while the unit is under power.   

• To prevent electrical or fire hazard, do not expose the transmitter to excessive moisture. 

• Do not operate the transmitter in the presence of flammable gases or fumes. Such an environ-

ment constitutes an explosion hazard.  

• Secure the transmitter to a 35 mm DIN rail. 
 

Symbols used: 

 

Caution (refer to accompanying 

documents) 
 

 
Caution, risk of electric shock. 

 

Equipment protected throughout  

by double insulation or reinforced 

insulation. 

 
Earth (ground) terminal. 

 Both direct and alternating current. 
  

Operating environment: 

• Class II (double insulated) equipment  

designed for use in Pollution degree 2. 

PROVISION FOR COOLING 

AL 1

AL 2

RESET

POWER

AL 1

AL 2

RESET

POWER

AL 1

AL 2

RESET

POWER

AL 1

AL 2

RESET

POWER

AL 1

AL 2

RESET

POWER

 
 

To avoid overheating, mount transmitters 

with ventilation holes at top and bottom. 

Leave a minimum of 6 mm 1/4”) between 

transmitters, or force air with a fan. 
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6.  TRANSMITTER FIELD WIRING 

 

 

 

 



       - 9 - 

7.  JUMPER SETTINGS 

 

 

Serial Signal Duplex Jumpers Termination Resistor* 

RS485 
Full None 

E6 a = Transmit 

E6 c = Receive 

Half E6 b + d** E6 c 

RS232 Full None None 

*  The termination resistor jumper settings should only be selected if the transmitter is the last 

device on an RS485 line longer than 200 feet (60 m). 

**  Or connect external BTX to BRX and ATX to ARX (same effect as internal jumpers). 

To reset communications to 9600 baud, command mode, Custom ASCII protocol, and Address 1, 

place a jumper at E1, cycle power, remove the jumper, and restart the transmitter.  
 

Analog Output J4 Pins Jumpers 

Current, 4-20 mA 1 Lo, 2 Hi E2 a + d 

Voltage, 0-10V 1 Lo, 2 Hi E2 b + c 

Voltage, -10V to +10V 3 Lo, 2 Hi E2 b + c 
 

Excitation Output Jumpers 

5V, 100 mA E3 a + c; E4 a 

10V, 120 mA E3 a + c; E4 b 

24V, 50 mA E3 b, E4 none 
 

Notes:  1. Jumpers for 4-20 mA output are shaded. Jumper settings are for main board Rev J. 

2. Attempting to draw more than rated excitation output current will shut down the output. 

3. The analog output is sourcing. Do not apply an external voltage. Applying an external 

voltage of 24 Vdc will burn out the transmitter main board. 
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WHEN TO CHANGE JUMPERS 

Your transmitter case does not need to be opened if jumpers have already been set by your 

distributor. Otherwise you will need to open the case and either set jumpers or verify that the 

factory default jumpers positions will meet your needs. Factory default jumper settings are for 

RS232 input and 4-20 mA output. 

HOW TO OPEN & CLOSE THE CASE 

  
 

The two clamshell halves of the case are held together with a bolt and a nut at each of the four 

corners. Use a Phillips screwdriver to remove the four bolts. The nut will then drop off, and the 

clamshell halves will separate. When closing the case, make sure that the ventilation grills are 

properly aligned.  

 

Caution: The nuts at each corner are not captive and are black. Take precautions 

so that the nuts do not get lost.  
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8.  PROGRAMMING YOUR TRANSMITTER 

 
OVERVIEW 

LTS serial input transmitters are programmed using a PC with a USB port and our free Instru-

ment Setup (IS) software, which provides a graphical user interface. This software allows 

uploading, editing, downloading and saving of setup data. To interface the LTS to the PC, two 

cables are plugged into each other: CBL04, a three-wire cable which connects the RS232 port 

of the LTS unit to a DB9 connector, and CBL02, an RS232-to-USB adapter cable which con-

nects the DB9 connector to the USB port of the PC. CBL02 incorporates and FTDI chip which is 

compatible with all versions of MS Windows. 

USING INSTRUMENT SETUP (IS) SOFTWARE 

As a first step, set User Account Control (UAC) of your version of Windows to "Never notify" so 

that Instrument Setup Software can create directories. Use Google for instructions. Power 

down and restart your computer for the UAC change to take effect. Download the file 

ISx_x_x.exe from our website and double-click on the file name. Click on “Install Instrument 

Setup Software” and follow the prompts. To launch IS software, press on Start => Programs => 

IS2 => Instrument Setup or on the desktop icon that you may have created. Following a brief 

splash screen, the Communications Setup screen below will appear. 
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In the Communications Setup screen, select Custom ASCII as the Protocol, as this is the 

factory default setting. Select “Transmitter LT” as the Device Type. Then click on the RS232 

button which also serves USB. In the resulting Establish Communications screen, select your 

Com Port and 9600 as the Baud Rate. Try different Com ports until one works. You will be able 

to change your protocol and baud rate later under the Communication setup tab. Click on 

Establish, and the two fields at the bottom of the screen should turn green. Click on Main 

Menu. The computer will remember your communication settings for the next time that you run 

IS software.  

 

From the Main Menu, click on Counter  => Get Setup to retrieve (or get) the existing setup data 

from your counter-transmitter. Click on View => Setup to bring up screens which allow you to 

easily edit the setup file using pull-down menus and other selection tools. You can download 

(or put) your edited file into the transmitter by clicking on Counter => Put Setup. You can save 

your setup file to disk by clicking on File => Save Setup and retrieve a previously saved file from 

disk by click on File => Open. 

After selecting a screen input field, pressing the F1 key will bring up detailed help information 

for that field.  

The LTS serial-to-analog converter needs to receive streaming serial data or commands from a 

Master. It cannot act as a master and send commands or ASCII characters. 
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9.  LTS SETUP FOR STREAMING INPUT WITH CUSTOM ASCII PROTOCOL 

 

 

Set Signal input to None. Set Time Out to 000.00 Secs if you want the analog output to be held 

indefinitely in the absence of a new serial input, or specify another time in seconds. Ignore 

Signal Input, Gate Time, Filter and Power-On Total. Under Display, select one of the Remote 

operating modes shown. Please see the screen captures below for more information. 

Remote A is an addressable input mode for up to 31 LTS units. The received ASCII text strings 

must be in a format like *#KSDDDDDD.A<CR> 

* =  Recognition character. Another command recognition character may be chosen to make 

the transmitter compatible with an existing system. The transmitter will still respond to 

an asterisk.  

# = Device Address Code from 1 to V. 

 Device # 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 

 Address Code 1 2 3 4 5 6 7 8 9 A B C D E F G H I J K L M N O P Q R S T U V 

K =  Command letter. Can be programmed using the Custom ASCII protocol to be H, K or L. 

S =  Optional sign of value. Use space or + for positive, - for negative.  

D =  Digits from 0 to 9. There can be 1 to 6 digits.  

. =  Optional decimal point. Can be anywhere between or after D digits. 

A =  Optional Alarm Character which overrides internal comparisons. A = no alarms, B = alarm 

1 active, C = alarm 2 active, D = alarms 1 & 2 active. 
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<CR>  =  Carriage return character. A <LF> line feed character may be appended but is ignored.  

Remote S is like Remote A but is not addressable. The absence of addressing makes Remote S 

faster than Remote A but limits it to point-to-point connections. The received value is stored 

where it may be selected for Alarm comparisons. If a Coded Alarm character is included, it 

overrides the internal alarm comparisons. The received ASCII text strings must be in a format 

like SDDDDDD.A<CR>. 

S =  Optional sign of value. Use space or + for positive, - for negative.  

D =  Digits from 0 to 9. There can be 1 to 6 digits.  

. =  Optional decimal point. Can be anywhere between or after D digits. 

A =  Optional Alarm Character which overrides internal comparisons. A = no alarms, B = alarm 

1 active, C = alarm 2 active, D = alarms 1 & 2 active. 

<CR>  =  Carriage return character. A <LF> line feed character may be appended but is ignored.  

Remote 1-4 allow multiple value to be extracted from Laureate transmissions. Data sequences 

with up to three data values can be generated by Laureate digital panel meters and transmitters 

(current reading, Peak, Valley). Data sequences with up to four data values can be generated by 

Laureate counters (Items 1, 2, 3, Peak). Please refer to our DPM and counter manuals. 

• Remote 1 = 1st value of value sequence SDDDD.DDSDDDD.DDSDDDD.DDSDDDD.DD<CR> 

• Remote 2 = 2nd value of value sequence SDDDD.DDSDDDD.DDSDDDD.DDSDDDD.DD<CR> 

• Remote 3 = 3rd value of value sequence SDDDD.DDSDDDD.DDSDDDD.DDSDDDD.DD<CR> 

• Remote 4 = 4th value of value sequence SDDDD.DDSDDDD.DDSDDDD.DDSDDDD.DD<CR> 

Remote C is used to extract data from ASCII strings that contains numeric data values 

surrounded by ASCII characters that may be printing or non-printing. It can accommodate 

selected Start and Stop characters. Any number of characters after the start character can be 

masked off up to the beginning of the desired data. From 1 to 6 numeric characters can be 

selected for the data, or up to 8 characters if a sign and decimal point are included. The 

received ASCII text strings must be in the format STXXXSDDDDDD.SP  

ST =  Start character. This can be any ASCII character in the received string. It must be at a 

fixed number of characters from the beginning of the desired data, which must have a 

fixed number of characters. Enter 00 if no start character is available. The stop charac-

ter then becomes the start character. 

XXX = Data to be ignored (Skip No.). Number of characters following the Start character to be 

ignored. 

S = Optional sign of value. Use space or + for positive, - for negative.  

D =  Digits from 0 to 9. There can be 1 to 6 digits.  

. = Optional decimal point. Can be anywhere between or after D digits. 

SP = Stop character. Set to 00 if no stop character is available. Note: Only either the start or 

stop character can be set to 00. The start and stop characters cannot be any character 

included in the data string. 
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Note:  The LTS is not plug and play. The format of the strings being received must be known 

in advance, including non-printing control characters. If you do not know the string 

format, contact tech support of the sending device's manufacturer, or use a terminal 

emulator program like HyperTerminal, PuTTY or RealTerm to view the actual trans-

mitted characters. 

 

Warning: Do not execute a Main Menu > Counter > Get Setup command to 

check setup information if you have placed the transmitter into the Remote 

C mode, since that will reset the transmitter to Remote A. In that case, you 

will need to reset the LTS to Remote C with Instrument Setup software and 

do a Put Setup to re-download your setup file into the LTS. Then discon-

nect your PC. 

The Control Inputs pull-down menu controls the effect of grounding Control Input 1, Control 

Input 2, or both.  Selections applicable to the serial input transmitter are the following: 

• Meter Reset, Function Reset, Meter Reset (first row). When this row is selected, 

grounding Control Input 2 causes a function reset, which resets latched alarms. 

• Activate Alarm 1, Activate Alarm 2, Activate Alarm 1&2. When this row is selected, 

grounding Control Input 1 activates relay 1, grounding Control Input 2 activates relay 2, and 

grounding both inputs activates Alarms 1 & 2.  

• Tare Enable, Tare if Enabled, Tare (last row). When this row is selected, grounding Control 

Input 1 (normally with a permanent connection) enables the Tare function. Momentarily 

grounding Control Input 2 stores the current digital value as an offset and subtracts this 

offset from the digital reading sent to the transmitter, resulting in a zero value for alarms and 

the analog output. This offset will also be subtracted from all new readings sent to the 

transmitter. To change the offset, momentarily ground Control Input 2 for the new input.  
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SETTING UP COMMUNICATIONS (REMOTE A & S STREAMING INPUT MODES) 

 

The above screen will appear under the Communication tab if Remote A or Remote S has been 

selected as Display Type under the Input+Display tab. These two modes are not able to extract 

data from an ASCII string that contains multiple data values and non-numeric characters. 

Under this tab, you can reselect your Baud Rate, Device Address, Serial Protocol, and Full/Half 

Duplex, even though you may have selected different values to establish initial communications 

with your PC. 

Set Output Mode to Command. Ignore the setting for CR(LF), Output Items, Output Filter, and 

Output Rate, as these items apply to digital transmission by a counter-transmitter, not to 

digital-to-analog conversion by the serial input transmitter.  
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SETTING UP COMMUNICATIONS (REMOTE C STREAMING INPUT MODE) 

 

The above screen will appear under the 

Communication tab if Remote C has 

been selected as Display Type under the 

Input+Display tab. This mode is able to 

extract data from ASCII strings that 

contain multiple data values and non-

numeric characters. Please see the F1 

Help screen to the right. 

Under this tab, you can reselect Baud 

Rate, Device Address, Serial Protocol, 

and Full/Half Duplex, even though you 

may have selected different values to es-

tablish initial communications with your PC. Select Full Duplex, not Half Duplex, even if you are 

using half-duplex RS485 wiring. 

Set Output Mode to Command. Ignore CR(LF), Output Items, Output Filter and Output Rate, as 

these items apply to digital transmission by a counter-transmitter, not to digital-to-analog 

conversion by the serial input transmitter.  

The number of characters shown can be up to 7, including 6 digits and a decimal point. Include 

leading zeros, such as 00300.0 
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SETTING UP THE ANALOG OUTPUT 

 

Under the Analog Out tab, set Source to Item 3. Under Range, select 0-20 mA, 4-20 mA, 0-10V 

or -10V to +10V as your desired analog output. Enter your Lo Range Reading and Hi Range 

Reading. These will create the two endpoint values of your analog output range. Only enter the 

numerical values. The decimal point is ignored. The span between the two values should be at 

least 256 counts to minimize the size of analog output steps. 
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SETTING UP RELAY ALARMS OPERATION 

 

Dual AC/DC solid state relays rated 120 mA are standard for alarm or setpoint control and are 

independently set up via the “Relay Alarms” tab. Set “Alarm Source” to “Item 3” as illustrated. 

For online help with any data entry field, press the F1 key.  

• Setpoint. The number to which the current reading is compared if deviation is set to zero. The 

reading is the count in engineering units that is transmitted digitally and is also used for analog 

output. For example, if the transmitted reading is in gallons/minute, the setpoint will be 

referenced to that reading, not to the raw pulse rate sent from a turbine flow meter. 
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 “Active High” On/Off setpoint control 

with deviation =0 

 “Active Low” On/Off setpoint control  

with deviation = 0 
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• Deviation. A positive number that can be added or subtracted from the setpoint, depending on 

the Deviation Type, to determine when an alarm becomes Active or Inactive.  

• Alarm Source. Depending on the Signal Input Mode and Function selected under the Input+ 

Display tab, the alarm can be assigned to any of up to three Items, for example to Item 1  

(A rate / B rate), Item 2 (A rate), or Item 3 (B rate). 

• Alarm State. If “Active High” is selected, the Active Alarm State is defined as being above the 

setpoint. If “Active Low” is selected, the Active Alarm State is defined as being below the 

setpoint. If “Disabled” is selected, the Alarm State is always inactive. 

• Relay State. A setting with ties the Relay State to the Alarm State. If “Active On” is selected, 

the relay will be closed when the Alarm State is 1. If “Active Off” is selected, the relay will be 

open when the Alarm State is 1. 

• Deviation Type. Three choices are offered: Split Hysteresis, Span Hysteresis, and Band 

Deviation. These define how Setpoint and Deviation are to be combined to set Alarm State. 

 

        Span Hysteresis for heater control      Band Deviation for component testing 

In Split Hysteresis, the relay opens (or closes) when the reading goes above the Setpoint plus 

one Deviation, and closes (or opens) when the reading falls below the Setpoint less one 

Deviation. Two Deviation limits lie symmetrically around the Setpoint to create a deviation 

band. A narrow hysteresis band is often used to minimize relay chatter. A wide band can be 

used for on-off control. 

In Span Hysteresis, operation is as for Split Hysteresis, except that the Setpoint is always on 

the high side, and a single Deviation lies below the Setpoint to create the hysteresis band. 

Span Hysteresis is considered by some to be more intuitive than Split Hysteresis. 

In Band Deviation, the relay opens (or closes) when the reading falls within the deviation 

band, and closes (or opens) when the reading falls outside. Two deviation limits lie symmetric-

ally around the setpoint to create the deviation band. Passbands around a setpoint are often 

used for go-no-go component testing. 
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• Alarm Type. Selections are Non-Latching and Latching. Under Non-Latching, the relay is only 

closed (or open) while the Alarm State is Active. Under Latching, the activated relay remains 

closed (or opens) until reset regardless of the Alarm State. Resetting is normally achieved by 

temporarily grounding one of the transmitter’s control inputs, which has been set to Function 

Reset under the “Input+Display” tab. 

• Alarms 1,2 No. Rdgs to Alarm. Selections are binary steps from 1 to 128. This is the number 

of consecutive alarm readings that must occur to create an Active alarm. Numbers higher than 

2 provide some Alarm filtering so that 1 or 2 noisy readings do not cause an Active Alarm. The 

Alarm becomes Inactive if one of the consecutive readings fails to be an Alarm reading. The 

Alarm readings counter then resets to 0. 
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10.  LTS COMMAND MODE WITH CUSTOM ASCII PROTOCOL 

 
Laurel’s Custom ASCII protocol  allows the LTS to receive data in the form of ASCII text strings, 

which can be either in a streaming Continuous Mode or in a Command Mode, as described in 

the user manual at https://www.laurels.com/downloadfiles/serialcom2.pdf.  

To set up the LTS for Command Mode using the Custom ASCII Protocol, use IS software as 

described in the previous section of this manual. Select the Custom ASCII Protocol and 

Command Mode. Select the Analog Out type as 4-20 mA, 0-10 mA, 0-10V or -10V to +10V. 

Enter the Lo Range and Hi Range numerical readings which will serve as endpoints for the 

selected output type. Set the LTS “Source” value to Item 3, which will be used for analog 

output interpolations and for relay setpoint comparisons. 

Example on how to output 12 mA:  

For setup: 

1. Set the LTS “Source” value to Item 3. 

2. Set the Analog Out type to 4-20 mA.  

3. Set the Lo Range Reading to 0 counts. 

4. Set the Hi Range Reading is 10000 counts. 

For normal operation, send *1H005000<CR><LF> 

Recognition character: * 

Address character: 1 

Command character: H 

Value: 005000 

Verify the analog output with a panel meter or multimeter. 

https://www.laurels.com/downloadfiles/serialcom2.pdf
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11.  LTS COMMAND MODE WITH MODBUS RTU PROTOCOL 

 

Laurel’s implementation of the Modbus RTU protocol allows the LTS to receive data in the 

form of Modbus commands. As for the customer ASCII Protocol in Command Mode, these are 

used to write values to a variable called “Item 3”, which will be used for analog output inter-

polations and for relay setpoint comparisons for relay action. Modbus commands are also 

available to overwrite setup parameters entered with IS Software “on the fly,” including the 

following: 

1. Change scale and offset or coordinates of 2 points parameters to generate the analog 

output derived from Item 3. 

2. Change setpoints to control relay action derived from Item 3. 

3. Force relay action regardless of Item 3 

4. Reset latched alarms by forcing a Function Reset. 

The Modbus RTU protocol for Counters, including model LTS, is described in the user manual 

at https://www.laurels.com/downloadfiles/serialcom2.pdf.  

See our Modbus Manual for Counters at https://www.laurels.com/downloadfiles/Modbus-

Manual-CTR.pdf for a Modbus RTU overview and for all available Modbus commands, not just 

those for model LTS. In particular, see the long section entitled, “FC03 (READ) & FC10 (WRITE) 

HOLDING REGISTER ADDRESSES.” Use Hi Word starting Register Addresses and an even 

number of Registers. The Register Addresses shown in this section apply to both FC03 and 

FC10. They are for Modbus numbering systems that start at 00 01 (Base 1). Subtract 1 from 

each Register Address for Modbus numbering systems that start at 00 00 (Base 0). 

To write values to Item 3 with Base 1 addressing, write the Hi Word applied to Item 3 to hex 

register address 006C, and the Lo Word applied to Item3 to hex register address 006D. With 

Base 0 addressing, the Hi Word address becomes 006B, and the Lo Word address becomes 

006C. The qModMaster example on the next page illustrates how to use Base 0 addressing to 

generate 4, 12 and 20 mA analog outputs.    

Example on how to send the value 999999 to Item #3 of an LTS using the Modbus protocol: 

1 10 00 6B 00 02 04 00 0F 42 3F F4 87 

Address: 01 

Function Code: FC10 

Holding Register: 006C 

Number of Registers Sent: 0002 

Number of Bytes Sent: 04 

Register Data: 000F 423F (999999 in decimal) 

CRC: F487 

https://www.laurels.com/downloadfiles/serialcom2.pdf
https://www.laurels.com/downloadfiles/Modbus-Manual-CTR.pdf
https://www.laurels.com/downloadfiles/Modbus-Manual-CTR.pdf
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12.  USING DIAGNOSTIC TOOL QMODMASTER 

1.  ABOUT QMODMASTER 

qModMaster.exe is a freeware Windows program which allows a PC to serve as a Modbus 

Master. It is an easy-to-use tool to verify communications, send requests to Modbus Slaves, 

and view their responses. qModMaster works well with Base 0, but not with Base 1, so use it 

only with Base 0 and subtract 1 from the Register addresses listed in our Modbus Manual for 

Counters. For more information, see the qModMaster section of our Modbus Manual for 

Counters at https://www.laurels.com/downloadfiles/Modbus-Manual-CTR.pdf.  

Download qModMaster from SourceForge at: 

https://sourceforge.net/projects/qmodmaster/files/latest/download 

Click on the downloaded file and install it in a directory of your choice. Create a desktop icon 

from the installed executable. Before using qModMaster, ensure that your LTSE transmitter 

has been set to Modbus RTU as explained in the Instrument Setup (IS) software section of this 

manual. 

2.  EXAMPLE: USE MODBUS COMMANDS TO OUTPUT 4, 12 OR 20 MA 

The task is to configure qModMaster to generate analog outputs of 4, 12 and 20 mA. This 

assumes that Instrument Setup (IS) software has already been used to set up the analog 

output as 4-20 mA with an Item 3 Lo Range Reading (for 0 mA) of +000000 and an Item 3 Hi 

Range Reading (for 20 mA) of +010000. These decimal values of 0, 5000 and 10000 form 32 

bit hex values of 0000 0000, 0000 1388 and 0000 2710. 

Launch qModMaster. A screen of the type shown below will appears. Under View, press Bus 

Monitor. Under Options, make the selections illustrated below. The entered serial port should 

be the number assigned by Windows Device Manager.  

 

 

 

https://www.laurels.com/downloadfiles/Modbus-Manual-CTR.pdf
https://sourceforge.net/projects/qmodmaster/files/latest/download
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Note that that the entry in counts to be sent to Item 3 can be in Hex or Dec formats. Under 

Commands, press Connect to make the data connection. The Bus Monitor should show Tx and 

Rx “values written correctly.” For information on these values, please see our Modbus Manual 

for Counters at https://www.laurels.com/downloadfiles/Modbus-Manual-CTR.pdf.  

The screen captures below are for Modbus TCP, but the syntax is the same for Modbus RTU. 

An external panel meter or multimeter connected to the analog output should show the desired 

output currents. 

 

https://www.laurels.com/downloadfiles/Modbus-Manual-CTR.pdf
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3.  EXAMPLE: USE MODBUS COMMANDS TO CONTROL TWO RELAYS 

Using BASE 0 addressing, alarm relays are controlled by writing to holding register 0x006F.  

Bit 0 controls Relay 1. Bit 1 controls Relay 2. 

First Alarm1 is forced by writing 01 to holding register 0x006. This turns Relay1 on. 

Then Alarm2 is forced by writing 03 to holding register 0x006. This turns Relay2 on. 

Both relays are turned off by writing 00 to holding register 0x006. The setup for this last 

command is seen in the qModMaster window. 

The Bus Monitor window displays the result of all three write commands. 
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13.  SPECIFICATIONS, LTS SERIAL INPUT TRANSMITTER  

 
Serial Data Input 

Signal Levels ...................................... RS232, full-duplex RS485, half-duplex RS485 (selectable) 

Protocols ............................... Modbus RTU, Modbus ASCII, Custom ASCII (software selectable) 

Custom ASCII Operating Modes .......................................... Streaming Mode or Command Mode 

Modbus Operating Mode ..................................................................................... Command Mode 

Serial Connector ........................................................................ Detachable dual 3-position plugs 

Analog Output (standard) 

Output Levels ............................................. 0-20 mA, 4-20 mA, 0-10V, -10V to +10V (selectable)   

Compliance at 20 mA .................................................................................. 12V (0-600 ohm load) 

Compliance at 10V ......................................................................... 2 mA (5 kohm minimum load) 

Output Resolution ....................................................................................... 16 bits (65,535 steps) 

Output Error ................................................................................................... < 0.02% of full span 

Output Update Rate ................ Determined by serial input rate. Approx 30/sec max at 9600 baud 

Dual Relay Outputs (standard) 

Relay Type .................................................. Two solid state relays, SPST, normally open, Form A 

Load rating ................................................................................... 120 mA at 140 Vac or 180 Vdc 

Relay modes ............... Active high or low, latching or non-latching, hysteresis or band deviation 

Power & Electrical 

Power to Transmitter ...............................................85-264 Vac or 90-300 Vdc (standard power) 

 .................................................................... 12-30 Vac or 10-48 Vdc (low voltage power option) 

Power Isolation .................. 250 Vrms between power, analog output, signal input, and serial I/O 

Transmitter Setup 

Transmitter Setup ................... Instrument Setup software using PC plus CBL02 & CBL04 cables 

Mechanical 

Case Dimensions ......................................................................................... 129 x 104 x 22.5 mm 

Case Mounting ................................................................................ 35 mm DIN rail per EN 50022 

Electrical Connections............................................................. Detachable screw plug connectors 

Environmental 

Operating Temperature ............................................................................................... 0°C to 55°C 

Storage Temperature ............................................................................................... -40°C to 85°C 

Relative Humidity ........................................................... 95% from 0°C to 40°C, non-condensing 
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14. WARRANTY

Laurel Electronics Inc. warrants its products against defects in materials or workmanship for a 

period of one year from the date of purchase.   

In the event of a defect during the warranty period, the defective unit may be returned to the 

seller, which may be Laurel or a Laurel distributor. The seller may then repair or replace the 

defective unit at its option. In the event of such a return, freight charges from the buyer shall be 

paid by the buyer, and freight charges from the seller shall be paid by the seller. 

LIMITATION OF WARRANTY 

The foregoing warranty shall not apply to defects resulting from: 

1. Improper installation or miswiring.

2. Improper or inadequate maintenance.

3. Unauthorized modification or misuse.

4. Operation outside the environmental specifications.

5. Mishandling or abuse.

The warranty set forth above is exclusive and no other warranty, whether written or oral, is 

expressed or implied. Laurel specifically disclaims implied warranties of merchantability and 

fitness for a particular purpose. 

Any electronic product may fail or malfunction over time. To minimize risks associated with 

reliance on Laurel products, users are expected to provide adequate system-level design and 

operating safeguards. Laurel’s products are intended for general purpose industrial or 

laboratory use. They are not intended nor certified for use in life-critical medical, nuclear, or 

aerospace applications, or for use in hazardous locations. 

EXCLUSIVE REMEDIES 

The remedies provided herein are Buyer’s sole and exclusive remedies. In no event shall Laurel 

be liable for direct, indirect, incidental or consequential damages (including loss of profits) 

whether based on contract, tort, or any other legal theory. 

Copyright 2006-2021 Laurel Electronics, LLC 17 December 2021 


